
How to use these handouts

This series of Premiere handouts give you a concise guide to using Premiere 5.1 to
capture and edit video.  They assume that you have used Premiere 4.2  in the past
and have some idea of the basic conventions of video capture and editing: things
like frame rate, the difference between NTSC and PAL, in points, out points and so
on.

Because these handoutsdeal with an upgrade rather than a completely new piece of
software they may well cover stuff you think you know already, however, there are
some important differences between Premiere 5 and earlier versions of Premiere, so
it would be a good idea to look again at what the handout says about a subject,
even if you think you know everything there is to know about it already. To get the
most from these handouts, use them while your working at a workstation.

What these handouts don’t do.

These handouts are not a substitute for the Premiere 5 User Guide which runs to
some 400 pages, or for Adobe’s own ‘Classroom in a Book’ tutorials, or for the
online Premiere help package accessible fromthe ‘Help’ menu in Premiere itself. A
copy of the Premiere 5 User Guide is available - for reference only - from Andy Lock,
room103 at Queens Gardens.

The Hooper building at Queens Gardens also holds a copy of ‘Adobe Premiere 5,
Classroom in a Book’, a series of Premiere 5 tutorials supported by a CD ROM.

Conventions

Menus

When describing different menus
and commands available in
Premiere, instructions like this one
are often used:

“From the Premiere File menu
select Capture / Movie Capture.” 

This means that Movie Capture is
one of a number of options open to
you once you have selected
‘Capture’ from the ‘File’ menu. 

The menu options in question are
shown in the picture on the right.

The “Active” window

On the Mac the ‘Active’ window is the window on top of all the other windows. You
can also tell its ‘Active’ because its title bar will be a dark grey as opposed to all the
inactive windows whose title bars will be a lighter grey. Clicking on an inactive win-
dow will make it the Active window.
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Capturing Video

Clearly, the first stage in working with video is to capture the video footage itself from
tape. When working with Premiere 5 on the TV and Film Macs, it is expected that
you will normally be working with DV or mini DV tape. It is also possible to capture
footage from SHS & S/VHS but this is a two step process which involves first record-
ing the footage onto DV tape and then capturing the footage from the DV tape.

Lets look first at capturing from DV tape into Premiere 5.

Creating project settings and saving your project.

1/. Turn on the DV deck and insert the tape.

2/. Launch Premiere 5 from the Mac’s Apple menu. You will be prompted to select
settings for your Premiere project.

3/. Select the ‘Load’ button from the right of the project settings window and then
from the list of available options choose DV PAL 44.1Khz and click OK. This means
you are set up to capture and edit DV material in PAL (UK televsion) format at a
screen size of 720x675 pixels, while your audio will be captured at 44.1 khz (CD
quality).

4/. Your Premiere project will now open. Among the windows displayed on the
screen is one labelled ‘Project Untitled’.  Select this window by clicking on it to make
it the ‘active’ window. Then go to your file menu and select Save As. In the dialogue
box that then opens give your project a name and save it in your named folder on
the ‘student work here’ drive.

For the time being ignore any other windows that may be open. 

Establishing Device Control and selecting ‘Scratch Disks’

In order to capture the clips which will go into your Prmiere project we now have to
establish a link between Premiere and the DV deck with the tape in it.

1/. Go to the Premiere File menu and select Preferences / Scratch Disks and Device
Control. The Preferences window will now open.

2/. In the Preferences window look first at the selected Device Control option: this
should read FireWire DV Device 1.1  If it reads something else, make sure the DV

deck is still switched on,  then click on whatever is dislpayed in the Device Control
field and select FireWire DV Device 1.1

Its this device which allows us to control the DV deck from within Premiere.

3/. Now turn your attention to the part of the Preferences window which deals with
‘Scratch Disks’. A ‘Scratch Disk’ is that part of the computer’s storage space used to
temporarily store data until you have decided where you wish to save it in the longer
term. The Scratch disk in this case should be set to read Student Work Here.

When you’ve finished doing both these things,click on OK to leave the Preferences
window.

Finding the clips you want to capture

The next step is to select the footage you want to capture.

1/. From the Premiere File menu select Capture / Movie Capture. This will bring up
the Movie Capture window (pictured below), displaying a range of controls, and also
a ‘Reel Name’ dialogue box. Don’t worry about this ‘Reel Name’ dialogue at this
stage, just click OK to make it disappear.
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Note: If when you are capturing video from DV tape, the computer tells you that
you are ‘Out of Memory’ or that the ‘Scratch Disk is full’, check to make sure that
the Scratch Disks you have selected have sufficient memory available on them:
usually well in excess of 200Mb. Ensure that your Scratch disks do not read ‘Same
as Application’.



2/. You can now begin to find the footage you want to capture by playing, rewinding,
fast-forward winding and / or slow advancing through your DV tape, using the con-
trols in the Movie Capture Window. 

At this point you should be able to see your footage both on the video monitor
hooked up to the DV deck and also in the small preview window contained within the
Movie Capture Window. There are a number of ways in which you can go about
capturing video from your DV tape.

Manual Capture in Movie Capture

The least complex way of capturing clips is
the method that allows you the least control:
simply set the DV tape playing from a point
somewhere before that at which you want
to start recording and then, when you reach
the point just before the beginning of the
footage you want to capture, click on  the
record button in the Movie Capture window. 

To stop capturing, simply click your mouse button and the captured clip should appear
on the desktop ready to be saved and dragged into your project window. This does the
job but it’s pretty clunky and with Premiere 5, there are easier ways to capture 
material.

Auto Record in Movie Capture

The auto record command lets you take advantage o fthe fact that you can control
the DV deck from within Premiere. To use auto record:

1/. Check the auto record box in the Movie Cpature Window

2/. Position the tape on the first frame you want to capture and then clickthe In>>
button in the Movie Capture window.  The time shown in the display next to the In>>
button should match that in the Current Time Display. 

3/. Now move the tape to the last frame you want to capture and click on the Out>>
button inthe Movie Capture window. The time shown in the display next to the Out>>
button should match that in the Current Time Display.

4/. Check again that you have put a cross in the Auto-Record check box and then
click on the Record button in the Movie Capture window. Premiere will now automat-
ically record the piece of footage you have just selected by marking your ‘In’ and
‘Out’ points. This process will automatically stop itself too, there is no need to inter-
vene. 

Before beginning to record, Premiere will make the deck go through a “Pre-roll”
sequence which will involve it rewinding and fast-forward winding. Don’t be alarmed,
this is perfectly normal.
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Shuttle: drag the slider to the
right to advance the tape, to the
left to rewind it. The further
away from the centre you pull
the slider, the faster the tape will
play. Release the slider, it will
spring back to the centre & the
tape will stop

Current Time Display: Shows the cur-
rent Time Code position of the tape in
hrs, mins, secs & frames.

‘Jog fwd’: advances tape one frame
at a time

‘Jog back’: reverses tape one frame
at a time

Note: Very occasionally, Premiere will not successfully be able to perform an auto capture.
If the deck, for example, carries on winding back and forth through your tape at high speed,
this is an indication that Premiere cannot find the ‘In’ or ‘Out’ points you have set. In this
rare eventuality, stop the deck and reprogramme the ‘In’ and ‘Out’ points. If the problem
persists complete a manual capture.
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Saving Clips

Having captured a clip either automatically or manually you should save that clip
before doing anything else. When the clip is captured it will appear in Premiere like
this:

You can see that it has no name, just a set of numbers to identify it. Having clicked
on the clip window to make it the active window, go to Premiere File menu and
select Save As. In the dialogue box which then appears, give the clip a name and
save it in the same place as you saved your project, this should normally be inside
your named folder on the Student Work Here drive.

Batch Capture

Because Premiere 5 is able to control the DV deck it is possible to perform ‘Batch
Captures’, that is, you can programme Prmiere to automatically capture a number of
clips at once.

1/. Select Capture/Batch Capture from the Premiere File menu. An empty Batch
Capture window, like the one shown below left, will appear. 

Click on this window to make it the active window and then choose ‘Save As’ from the
File menu. By saving your Batch Capture details you can make them accessible to you
in the future. A saved batch capture list produces an icon like the one shown below
right.

2/. With your DV tape in the DV deck, go back to the File menu and select Movie
Capture. This will open the Movie Capture window. You should now have both the
Movie Capture and Batch Capture windows open.

3/. In the Movie Capture window select Auto Record and go through the process of
setting In>> and Out>> points for the first clip you want to capture (as discussed ear-
lier under ‘Auto Recording’). Then click on the ‘Log In/Out’ button . . .
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Note: When you saved your project, you created an icon which looks like the one
below left, now saving your clip, you create an icon  like the one below right. Your
clips are separate files from your project file and both your clips and your project
must be saved in order to complete the project successfully.

The ‘Log In/Out’ button



4/. Clicking on the ‘Log In/Out’ button in the Movie Capture Window, will open this
dialgue box, which invites you to enter a ‘File Name’ for the clip you are going to cap-
ture; to choose which batch list you want to send this information to. The dialogue also
allows you to add any comments you want to about the clip.

In this case we have called the clip “Man on Steps”, we are sending it to the Batch
List we have just created and saved, the list called “Waiting proj” and we have added
the comment “old fella on Museum steps”. 

When we click on OK, all of this information will appear in the Batch Capture list 
window. Once you have set up the details for the first clip you want to capture, you can
repeat steps3 and 4 to set details for the capture of more clips. 

As you add clips to the Batch Capture List, they will appear in the Batch Capture win-
dow as shown below: The window displays In>> and Out>> point information, the
duration of the clip to be captured, the name you have given it and any comment you
may have added. 

(As clips are captured, the ‘diamond’ next to their name in the Batch Capture list
changes to a ‘√’ character).

5/. When you’ve added all the clips you want to capture to your Batch Capture List,
look to the bottom of the list and find the ‘Sort’ button, shown below. 

Clicking on the ‘Sort’ button arranges the clips you have listed in chronological order
depending on their position on the DV tape. Once you have sorted your clips you are
now ready to begin capturing. 

6/. Click on the ‘Capture’ button and Premiere will begin to capture all of the clips you
have instructed it to record. Once the process is complete, the clips you have captured
will automatically be added to Premiere’s project window, as shown below:

These clips are now ready for you to edit with, but before you get started, it’s a good
idea to check where Premiere has actually saved these Batch Captured items. If the
files are not yet saved inside your named folder on the Student work Here Drive, make
sure that you drag them into that space, for safe keeping. 

Movie Capture & Batch Capture: Additional Features & Controls

Both the Batch Capture and Movie Capture options offer a number of features which
allow you additional control over the capture process. When you open the Movie
Capture or Batch Capture options from the File Menu a new menu item called either

‘Movie Capture’ or ‘Batch capture’
will appear on the Premiere Menu
Bar.

These new menu items, only visible
with Batch and / or Movie capture
open, give you access to the 
following additional controls . . .
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Note: If you move clips, Premiere may ask you later where they are. If it does
this, simply navigate to your named folder, where the clips should be stored, and
select them there, Premiere will then update its information about where they are
stored.



The Movie Capture Menu The Batch Capture Menu
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Activated when Movie Capture is selected
from the File Menu, The Movie Capture
Menu allows you to change a number of
important settings controlling the capture
of video and audio. 

You normally only need to access these
settings, however, when you are 
troubleshooting.

Correct Capture settings

Correct Audio Capture settings

Correct Video Capture settings

Note: The √ Record Video & √ Record
Audio options can also be unchecked to
stop the capture of either video or audio.

The Batch Capture Menu also offers a range of
options, some of which are worth mentioning
here.

Capture Handles  

The Batch Capture Menu allows
you to add ‘handles’ or extra bits of
footage at the beginning and end of
the clips you are capturing. If you
set the handles to ‘10’ for example,
Premiere will capture an additional
10 frames at the beginning and end
of each clip specified
in the Batch List.

Recording Settings

Like the Movie Capture Window, the Batch Capture
window allows access to the video and audio cap-
ture settings shown opposite (These can be
accessed from the top 3 options in the menu).

Importing & Exporting 
Batch Lists as Text Files

Having Created a Batch List of clips you want to
capture, as well as saving the Batch List itself as
aPremiere file, you can also export it as a text file. 

The text file contains information about the ‘in’ and
‘out’ points you have specified for a tape, as
recorded by the DV tape’s time code .

You can reimport the text file into Premiere at a
later date and it will reopen as a new Batch List
which you can use straight-away with the tape the
list refers to.

Send In/Out to 
Movie Capture

If you already have a batch list
with items in it, you can use this
option to open the Movie
Capture Window



Recording Video and Audio from VHS / SVHS  Tape

You can’t actually capture video and audio directly from VHS or SVHS tape into
Premiere 5 on the G4 or G3 Macs. Instead you have to first record the VHS / SVHS
material manually onto DV tape.

1/. Switch on the SVHS deck attached to your Mac workstation and put the tape
containing your VHS / SVHS footage into it.

2/. Switch on the DV deck attached to the same workstation and place a DV tape
into it.

3/. Using the controls on the SVHS deck find that part of the SVHS / VHS tape you
want to transfer to DV.

4/. Make sure that the there are wires connecting the video and audio outputs on the
SVHS deck to the audio and video inputs on the DV deck (Do not rewire anything
without consulting a Learning Adviser first).

5/. Look at the digital display panel on the front of the DV deck. In the bottom right
hand corner, the display should read: either ‘Input Video’ or ‘Input S Video’. It should
not read ‘Input DV’.  If the leads going into the back of the DV deck are Composite
leads (see above left), then the DV deck should read Input Video. If the leads going
into the back of the DV deck are S-Video leads (see above right) then the DV deck
should read input S Video.

6/. You can adjust the input details for the DV deck by opening the flap on the front of
the deck and finding the button labeled ‘Input Select’. Pressing this button will swap
between Input DV, Input S Video and Input Video.

7/. Having selected the correct input and having cued up the tape in the SVHS deck,
the next thing to do (if you are recording audiuo as well as video) is to check the sound
recording levels on the DV deck.

On the front of the DV deck, next to the headphones volume dial are two dials which
control the audio input levels, the volume at which you record sound onto the DV tape.
While playing that part of the SVHS / VHS tape you want to record you should adjust
these levels so that the audio on the digital display on the front of the DV deck is 
peaking at about -3 or -4 db. Having done this, you are ready to record. 

8/. Cue up the tapes in both decks. The SVHS / VHS tape should be set up a few 
seconds before the footage you want to record and set on pause.

9/. To start recording on the DV deck use the buttons on the front of the deck. You
need to press both the Record and play buttons, Press and hold down the record 
button first and then press the play button, otherwise the DV tape will simply play. If
you are recording a red light will show on the DV deck display panel.

10/. To halt recording, press the pause button on the DV deck followed by the stop 
button. With your analogue material transferred to DV tape you can now capture into
Premiere, from DV, as already discussed.
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If a Composite lead connects the
DV deck and the SVHS deck,

select Input Video

If an S Video lead connects the
DV deck and the SVHS deck,

select Input S Video

The Input Select button



Printing Movies to DV tape and S/VHS tape 
From Premiere 5

Having completed your Premiere Project and / or made a Movie out of your work, you
will probably want to put a copy of your work onto either DV or S/VHS tape. 

The process for doing this is straightforward, and the good news is that although you
can’t record into Premiere directly from SVHS or VHS tape you can print directly from
Premiere onto these formats as long as there is a DV deck lin ked up in between the
computer and the SVHS deck. Printing to DV tape and SVHS tape uses the same
process.

Before you output your project / movie to tape, add a ‘Universal Counting Leader’ to
its beginning. This is good practice anyway and gets around an inherent problem with
the current hardware / software set-up.

Adding a Universal Counting Leader to a Project

1/. Go to the tool palette at the top left of the Timeline window. Click and select as
shown below: click on the rectangle tool with the broken line and from the pop-up
menu that appears, select the rectangle tool with two horizontal arrows in it. This tool
allows you to select all the layers in the Timeline window at once.

2/. Using the multiple layer selection tool, go to your Timeline window and, clicking on
one of the layers in your project, drag all of the different layers to the right by about 12
seconds, as shown below.

It’s into this gap at the beginning of the project that we are going to place the Universal
Counting Leader (UCL).

3/. To create a UCL first select Project > Create > Universal Counting Leader . . .
this will open the UCL window, shown below. Make whatever alterations you need to,
to the appearance of the leader and click OK. The UCL will now appear as a clip in the
Premiere Project window.

4/. Drag the UCL clip from the Project Window to the Time Line Window and place it
the gap created by moving your other clips to the left. Now, using the Multiple Track
Selection tool again, drag your other clips back to the right until they meet up with the
end of the UCL in the Timeline.

Preparing to Print to Video

5/. With your completed project or movie in the timeline with its UCL, make sure the
blue work area bar is stretched to cover whichever part of the footage you want to
‘print’ to video.
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The Work area bar, make sure this
is stretched to cover that part of the
project you want to print onto video

The finished movie or project in your
timeline



6/. Next, take a look at your DV deck, regardless of whether or not you are recording
onto S/VHS or DV, you need to make sure that the input option on the DV deck is set
to ‘Input DV’. 

This takes account of the fact that we are recording DV footage output from the Mac.
If the input on the DV deck is set to S Video or Video, the Print to Tape process will
not work.

7. With the DV deck input set-up correctly select Export > Print to Video . . . from
the Premiere File menu. This will open the ‘Print to Video’ window (see below) in this
window you can in theory choose options such as the amount of blank, black screen
and / or colour bars you want to see on tape before your footage appears. Ignore
these options however as they do not work. Instead, click OK and the ‘printing’
process will begin. 

Before carrying out recording for real, it is best to do a dry run in order to check the
audio input levels on your DV and / or S/VHS decks. These levels will determine the
final volume of your audio once it is recorded to tape.

8/. To carry out a dry run, complete step 7  as above, but do not press any of the record
buttons on the DV or S/VHS decks. Instead let the movie footage you are outputting
‘preview’ on your video monitor. While this is happening you can check and adjust the
audio input levels on whichever deck you are recording onto. 

Make sure the audio is peaking at about -3db: adjust the ‘Audio Input Level’ / ‘Audio
Rec. Level’ dials on the front of the appropriate deck until you have the required audio
level.

9/. Once you have carried out a successful dry run, go through the process again. This
time though set up your record deck at record/pause before hitting the OK button in
the ‘Print To Video’ window (shown above). Once you hit the OK button release the
pause button on the DV / S/VHS decks - as appropriate - to begin recording.
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Note: Because you have to start your DV or S/VHS decks recording by manually pressing
their play/record buttons, simply clicking OK in the ‘Print to Video’ window will not actually

result in anything being recorded onto your video tape.

Note: If you need to stop the recording process at any time. It can be stopped at
the deck by hitting the pause button and at the computer by pressing  and full-

stop keys simoultaneaously. 


